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1 Included 

1.1 VIBROPORT 8000 Hardware and Software Programs 

The VIBROPORT 8000 is the same hardware as the VC-8000 Machinery Protection System (MPS). 
However, the VIBROPORT 8000 is packaged as a portable solution; This includes cables and 
adapters for simple connection to 3rd party vibration systems. The following hardware and software 
are included with the VIBROPORT 8000.  

 

Picture (or Icon) Name Description 

 

VIBROPORT 8000 
Configuration software 

Spreadsheet style software for 
configuring the VIBROPORT 8000.  

 

 

Configuration Files Example VIBROPORT 8000 
configuration files. 

 

SETPOINT PI/XC  
Adapter software 

Data collection software.  
 

Connects to the VIBROPORT 8000 
and saves the data to the CMS-XC 
Database (Job sub-folder). 

 

SETPOINT CMS software Visualizer for condition monitoring 
data and plots including Trends, 
Spectrums, Orbits, Timebase, etc. 

 

24 V DC Power Adapter (x1) Use to power the VIBROPORT 
8000. 

 

USB cable (A-Male to Mini-B) 
(x1) 

 

Use to configure the VIBROPORT 
8000 and to perform maintenance 
functions. 

 

Ethernet cable (x1) Use for CMS-XC data collection and 
for VIBROPORT 8000 configuration. 
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Picture (or Icon) Name Description 

 

BNC Breakout Cable (1 each 
per UMM ordered) 

Used to connect to buffered outputs 
of 3rd party vibration systems.  

 

UMM to RJ45 Adapter (1 
each per UMM ordered) 

Provides an RJ45 connector (Signal 
and Common) for UMM module. 

1.2 Additional Software 

The VIBROPORT 8000 is the same hardware as the VC-8000 Machinery Protection System (MPS). 
The VC-8000 MPS software is provided because it is required for hardware maintenance and 
advanced troubleshooting such as password reset, and firmware upgrades. 

Picture (or Icon) Software Description 

 

VC-8000 Rack Setup 
(Configuration) software 

VIBROPORT 8000 users will 
normally not use this software. 

 

VC-8000 Rack  
Maintenance software 

VIBROPORT 8000 users will need 
this software for advanced 
maintenance functions. 

 

VC-8000 Data Simulator VIBROPORT 8000 users will 
normally not use this software. 
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2 Start Here 

2.1 Setup 

This quick start guide will walk the user through a simple setup and configuration of the VIBROPORT 
8000 using a laptop for field data collection. 

To complete the quick start setup, you will need the following: 

• Laptop (or PC) 

• +24 V DC power adapter 

• USB cable (A-Male to Mini-B) 

• Ethernet cable 

• VIBROPORT 8000 configuration software 

• SETPOINT PI/XC Adapter software 

• SETPOINT CMS software 
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2.2 Start VIBROPORT 8000 Configuration Software 

2.2.1 Configure the IP Address 

The VIBROPORT 8000 needs an IP Address compatible with your laptop. In this section we configure 
the IP address using the USB connection to the rack. Once the IP is configured, you will use the 
Ethernet connection for both configuration and CMS-XC data collection.  

Save the USB cable, it may be needed in the future for maintenance activities. 

Action Screen Capture 

Install and start the VIBROPORT 8000 configuration 
software. 

     

Connect the USB cable to any UMM module. 

 

After connecting the USB cable, the software will 
connect automatically. (just wait about 15 seconds). 

The connection status is shown in the bottom  
left corner of the software.  

From the Home tab, select Get - to retrieve the 
existing configuration from the VIBROPORT 8000  
(Or ‘Open’ a sample configuration). 

 

Select the Ethernet tab and set the new IP Address. 

If there is no default gateway, then set it to the same 
IP address.  

 

Select Prepare to Send, then Commit. 

Configuration errors will be shown on the Commit 
screen (if any). 

    

Enter the Administrator Password 

(The default password is: vibro) 

The configuration is sent, and the IP address will be 
updated. 

 

Done.  
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2.2.2 Connect Via Ethernet 

Once established, the Ethernet connection can be used for both configuration and data collection.  

Action Screen Capture 

Connect your laptop Ethernet port to the 
VIBROPORT 8000 CMS ethernet port on the SAM 
module.  

 

 

Use the command prompt on your computer to verify 
that you can ping the rack.  

 

Note:  
For troubleshooting the Ethernet connection see  
Section 5 Troubleshooting.  

Launch the VIBROPORT 8000 software. 

From the Home tab, select Connect. 

 

Note:  
Make sure the USB cable is not connected. When 
the USB cable is connected, the Ethernet Connect 
icon is disabled. 

 

Enter the following(example): 

• IP Address: 192.168.0.12 (or other) 

• Account: Administrator 

• Password: vibro (or other) 

 

Verify the connection: 
 

The connection status is shown in the bottom left 
corner of the software. 
 

 
 

Done.  

 

 

NOTE 

Save the USB cable. The USB cable is used for configuration, maintenance, and is 
required for password resets (if you forget the password). 
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2.3 Start the SETPOINT PI/XC Adapter Software 

VIBROPORT 8000 users will need a laptop for data collection and storage (CMS-XC). CMS-XC is a 
simple flat file format that is written to the laptop hard drive; CMS-XC does not use PI, or SQL or any 
other database.  

To store CMS-XC data on your laptop you will need to install the SETPOINT PI/XC Adapter software. 
To set up the Adapter, complete the following steps. 

Action Screen Capture 

Create a storage folder for CMS-XC Data.  

 

For example: “C:\Setpoint CMS-XC Data” 

This will be the main folder - for all jobs. 

 

Tip:  
Do not use a Desktop or a “My Documents” folder 
location. These folders are deleted if the user is 
removed from the computer. Use a folder on the 
main drive (C:\ or D:\). 

 

Install and start the SETPOINT PI/XC Adapter 
software 

 

Under the File tab, select CMS-XC and set the 
following: 

• Collect Data (Enabled) 

• Allow users to connect… (Enabled) 

• XC storage folder location (set to the folder you 
just created). 
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Action Screen Capture 

Under Home, select Add. 

 

• Enter the VIBROPORT 8000 IP address  
(i.e. 192.168.0.12) 

• Set the CMS-XC Database Name (i.e. Job 1) 

 

Note:  

When you start data collection the adapter will 
create the job sub-folder (i.e. Job 1). 

You will never need any of the Advanced settings. 

 

 

Connect your laptop to the VIBROPORT 8000 CMS 
Ethernet port (SAM module). 

 

 

 

Make sure you can ping the rack.  

 

Note:  

For troubleshooting the ethernet connection see 
Section 5 Troubleshooting. 

 

Press Record. 

 

Two green checkboxes indicate: 

• Successful connection to the VIBROPORT 
8000 

• Successful creation of (or connection to) 
the CMS-XC job sub-folder. 
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Action Screen Capture 

Note: 

 
Each time you start a new Job (i.e. enter a new 
CMS-XC database name): 

• A new sub-folder will be created (i.e. Job 1, 
Job 2, etc.) 

• A new shortcut (0-byte file) will be created. The 
shortcuts are used to open CMS data after a 
job is completed (i.e. not a live data 
connection). 

 

Done.  
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2.4 Start the SETPOINT CMS Software 

To view and analyze CMS-XC data you will need to install the SETPOINT CMS software. CMS 
software can be used to view live data (current job), or to view data from previous jobs. It can also be 
used to view “.cms” export files sent to you for analysis (VIBROPORT 8000 or VC-8000). 

2.4.1 Initial CMS Setup 

The first time you start CMS you will need to complete the following steps. 

Action Screen Capture 

Install and start CMS Software 

Note: 

Registration of the software is required (there is  
30-day trial period). 

 
 

Select File, Open Database, Add Database 

 

Select Add CMS-XC 

 

This will add your laptop (as a live connection) for 
CMS-XC data. 

 

The pop-up screen will show your computer name.  

Select OK. 

 

Note: 

There is no need to specify an account. 

 

CMS will start and connect. 

Notice (at the top of the screen) that CMS is 

connected to” the laptop”. This is a “live data 

connection” which brings data in from the current 

Job (XC-Database) configured in the PI/XC Adapter. 

Also, notice (bottom right) that the “running man” 

icon is active, indicating that live data is available. 

 

 

Done.  
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2.4.2 View CMS Data (Current Job) 

The next time you open CMS software it will connect to the “Live” database automatically. If it does 
not you can reconnect as shown here: 

Action Screen Capture 

1. Start CMS Software 

2. Select File, Open Database. 

3. Select your Computer Name. 

4. Select the Job (XC-Database) name. 

 

Note:  

If CMS has not yet updated the Job name, go 
ahead, and select it anyway.  The Job name will 
update eventually… 

 

Also, make sure the PI/XC Adapter is running. 

 

Done.  

2.4.3 View CMS Data (Previous Job) 

You can view data from previous jobs as follows: 

Action Screen Capture 

Start CMS Software 

 

From the File menu select Open File, and then 
select the Open File icon. 

 

Note: 

This doesn’t require the PI/XC Adapter to be 
running; the data is already stored. 

 

Browse to the CMS-XC Storage folder and select 
the Job shortcut. 

 

Done.  



 

© Brüel & Kjaer Vibro ● S000022.002 / v01 ● Page 15 of 32 
Technical alterations reserved! 

Brüel & Kjaer Vibro │ Quickstart Guide  
 VIBROPORT 8000 

 Start Here  EN 
   

UNRESTRICTED DOCUMENT 

2.5 Connecting the Cables to the Signal Source 

Use the UMM to RJ45 Adapter (1) and the BNC to CAT5 cable (4) to connect to the field device (i.e. 
Bently Nevada 3300 protection rack). If additional cable length is needed, use a standard ethernet 
(CAT5) cable (2) and an ethernet cable joiner (3) (not provided). 

 

Figure 2-1) Cabling 

 

 

TIP 

Ethernet (CAT5) cables combine multiple conductors into a single cable. To minimize 
signal cross-talk, keep total Ethernet cable lengths less than 10 meters (30 feet). 
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2.5.1 Grounding 

The On-Line Protection System signal COM will be the reference COM for both systems  
(see Figure 2-2). Both the VIBROPORT 8000 COM and the laptop (or PC) COM should be floating.  

An Ethernet connection from your laptop to the VIBROPORT 8000 will not affect grounding. However, 
a USB connection can affect grounding. USB connectors in laptops and PC’s tie Chassis GND to 
Signal COM; Do not use the USB cable when connecting to an On-Line Protection System. 

 

 

Figure 2-2) Device signal COM will be the reference COM for both systems 

The COM to GND jumper should be removed when connecting VIBROPORT 8000 to an On-Line 
Protection System. The COM to GND jumper should only be installed if the VIBROPORT 8000 is 
connected directly to sensors in the field.  

 
Figure 2-3) Shorting COM to GND (only when using VIBROPORT 8000 with field sensors) 

 

 

WARNING! 

To avoid ground loops and potentially tripping the unit, proper grounding must be 
checked before connecting VIBROPORT 8000 to any on-line monitoring protection 
system 
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2.6 Beginners Job Checklist 

This checklist may be helpful as you set up your first job. 

# Connection Checklist X 

1.  VP-8000 COM is floating (See Section 2.5.1).  

2.  Laptop COM is floating (See Section 2.5.1).  

3.  All cables are secure and out of the way – no tripping hazards.  

4.  Laptop sleep/hibernation settings have been modified (See Section 5.6).  

# Configuration Checklist X 

5.  Phase Trigger located in Channel 4 (any slot 4-8).  

6.  XY Pairs are in channels 1,2 or 3,4.  

7.  ‘Group Channels’ is selected (usually for all RV, and Phase Trigger channels).  

8.  CMS Navigation Path (or Group) is assigned for every channel.  

9.  Asynch and synch waveform settings are acceptable for this machine. 

Note: For fast speed machines (> 12,500 RPM) the sample rate must be reduced, or 
synchronous waveforms will not be collected (see section 7.4.1.3 – Configuring Synch 
Waveforms for max speeds).  

 

10.  Machine Direction of Rotation is correct (Channels tab, Phase Trigger view)  

11.  All channels in OK (green) – with good Gap voltages.  

12.  SD card is installed (as a backup).  

13.  Use numbers in the names (01, 02, etc.) to force the order of tags (and groups) in CMS 
software (see section 3.6). 

 

# PI/XC Adapter Checklist X 

14.  Collect XC Data is set (File Menu).  

15.  Rack IP Address is correct (Home, Edit, IP Address).  

16.  Job name/folder is correct (Home, Edit, XC Database Name).  

17.  PI/XC Adapter is started and two green checkmarks are shown.  

# CMS Checklist X 

18.  Verify Computer Name is shown (live data connection), and the correct Job Name is 
shown in the Navigation Pane. 

 

19.  Verify Running Man Icon is active, and data is coming in…  
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2.7 More Information 

For more information on the VC-8000 hardware capabilities, please see the following manuals 
available for download at the BK Vibro website (look for the link to “Product Instructions” in the 
Downloads section). 

Document Number Title 

S000022001 VIBROPORT 8000 Quick Start Guide (this document) 

S1079330 VC-8000 Operation & Maintenance Manual  

S1176125 SETPOINT Condition Monitoring System Operation Manual 

S1342998 Reciprocating Machines Applications Manual 

S00002001 Rolling Element Bearing Applications Manual 
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3 Configuration Tips 

3.1 Default Units 

Set the default units (imperial or metric) from the Home ribbon. New 
channels will default to these units. 

This setting does not affect existing configuration settings, only new 
channels.  

3.2 Select Tab (and View) 

The software navigation is grid based (very similar to 
Microsoft Excel). There are six tabs, select a tab to edit the 
properties. 

• Channels (with multiple Views)  

○ Summary 
○ Data Collection 
○ Phase Trigger 
○ Others… 

• Waveforms 

• Measurements  

• Live Data 

• Ethernet 

• Modules 

The Channels tab has multiple views. The view allows different channel types (with different settings) 
to be grouped together and edited more easily. 

3.3 Copy and Paste 

The software supports copy and paste functions. You can copy a single cell and paste to multiple 
cells. You can also copy a block of cells (i.e. 4 cells) and paste to a block of cells (i.e. 4 cells). You 
can also copy and paste from Microsoft Excel. 

 

Figure 3-3) Pasting Across Multiple Cells 

Figure 3-1) Default Units 

Figure 3-2) Select Tab and/or View 
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NOTE 

Some cells do not support ‘paste’ functionality. 

 

3.4 Sort and Multiple Column Sort 

Click the mouse on the column header to sort by that 
column. Click on the column label again to change the order 
of the sort.  

You can sort multiple columns.  Sort the first column by 
clicking the mouse on the column header. Then press the 
SHIFT key and click the second column header.  Then press 
the SHIFT key and click the third column header.  

In the screen capture, the grid was sorted first by 
Measurement, second, by Slot, and then third, by Channel.  

3.5 Grid Filter 

Use the filter to show only the rows you are interested in 
seeing. The filter is not case sensitive and applies 
(simultaneously) to all column headers marked with an 
asterisk.  

3.6 Disable Unused (Spare) Channels 

Disable unused channels from the Channels Tab. Deselect 
the box in the ‘On’ column. 

3.7 Naming Convention 

CMS sorts the list of Tag and Asset (Navigation Path) 
Names alphabetically. To force CMS software to sort names 
in the order you prefer, use a prefix in front of the name.  

3.8 Orbit (XY) Pairs 

All XY pairs need to be in channels 1 & 2 (or channels 3 & 4) 
of the same UMM. 

All XY pairs must have the same CMS Navigation Path 
name. 

  

Figure 3-4) Use SHIFT + mouse click to multi-sort 

Figure 3-5) Grid Filter 

Figure 3-6) Naming Convention 
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3.9 Phase Trigger Channels 

The VIBROPORT 8000 (8P rack) rack allows for five Phase Trigger channels maximum. Phase 
Trigger channels can only be configured in channel 4 of a UMM (slots 4-8). Slot 3 does not support a 
phase trigger. 

 
Figure 3-7) Phase Trigger channels selection. 
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4 Job Management 

The following sections will help you with Job, configuration, and data management.  

4.1 Start a New Job 

Each time VIBROPORT 8000 is being setup for a new job you will need to enter a new CMS-XC 
Database Name, as follows: 

• Start the SETPOINT PI/XC Adapter software 

• Select Edit 

• Enter the new CMS-XC Database name (Job name) 

When data collection is started, the Adapter will create the new job sub-folder automatically. The new 
sub-folder will be located under the main data storage folder. 

 

 

Figure 4-1) Create a New Job (Sub-Folder) 

Job (data) sub-folders are separate from each other. For example, the data in the “Job 3” folder 
cannot be merged with data in the “Job 2” folder. CMS can only view data from one folder at a time. 

 

Figure 4-2) Job (Sub-Folder) 
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4.2 Share CMS Data 

With SETPOINT CMS software it is very easy to share data. SETPOINT CMS software is free, so any 
person can download the software. 

The easiest way to share data is to export the data to a “.cms” (or CMS) file. A CMS file is limited to 
one week of data maximum. Normally, the data files are focused on a specific event and are only 2-3 
hours of data. To create a CMS file, follow these steps: 

Action Screen Capture 

Open the CMS Software and connect to the 
appropriate database (or file). 

 

Select the points that you want included in the 
export. 

 

Select the time range that you want included 
in the export. 

 

Select File, Export. 

Enter a file name, and save the file. 

The file will have a “.cms” extension (i.e. 
job1.cms). 

The CMS file can be emailed or placed in a 
shared folder etc. Anyone with SETPOINT 
CMS software can open and view the file. 

 

Done.  
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4.2.1 Time Zone of CMS Data 

CMS files contain time data in UTC time. When a user opens a CMS file on their laptop, the CMS 
software will show the data using the time zone of that laptop.  

For example, if you send data to a colleague in a time zone that is +3 hours. The event that occurred 
at 2 AM, will be shown at 5 AM on his laptop. 

If your colleague prefers to see the data displayed in the original time zone, he must change the time 
zone of his computer to match the time zone where the data was 
collected. 

4.3 Archive a Job 

To archive job data, copy the Job folder and the Job shortcut to 
the archive location. CMS Export files can also be created and 
archived for specific events.  

4.4 Modify Data Collection Parameters 

The VIBROPORT 8000 is based on the VC-8000 on-line protection 
system. An on-line system gets configured once and will keep those settings for years. The 
VIBROPORT 8000 will be configured many times, for many different machines. It is important for the 
user to recognize some limitations with the VIBROPORT 8000 system when making configuration 
changes. 

For example, the VIBROPORT 8000 does not track configuration changes made during the current 
job; it only remembers the most recent configuration settings. For example, if a user lowers the FMax 
setting from 2000 Hz to 1000 Hz, all the samples for that job (even those already collected) will now 
display as if the FMax was 1000 Hz.  

Best practice is to always start a new Job (XC-Database sub-folder) whenever a configuration change 
is made.  

 

 

Figure 4-3) Archive folder 
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5 Troubleshooting 

5.1 CMS Navigation path, or CMS Channel Name Errors 

If a lot of configuration changes have been made, you might see duplicated channels in CMS, or a 
CMS Navigation Path (Asset) name that is incorrect. In this situation it is best to start a new job.  

To start a new job. Open the PI/XC Adapter, stop data acquisition, and change the Job name (XC 
Database Name). This will create a new job sub-folder (with new data/config files). Data collected 
previously will stay in the old job folder.  

5.2 Configuration Changes are not Updated in CMS 

If you do not see your configuration changes updated in CMS, open a CMS export (.cms file) and 
then go back and re-connect to the CMS-XC (Live Database). This forces CMS to refresh and see the 
recent changes in the CMS config files. 

5.3 No Live Data (Running Man Icon is Inactive) 

VIBROPORT 8000 can only show live data with a connection to the live database (laptop computer 
name). The current (or live) database is defined in the Setpoint PI/XC Adapter (i.e. Job3). When CMS 
is connected to the live database: 

1. Your computer name will be shown at the top of the CMS screen. 

2. The CMS-XC Database (Job) name will be shown in the Navigation Pane. 

3. The Running Man icon (live data) will be active 

 

 
Figure 5-1) Live Data Connection 
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5.4 Software Errors 

5.4.1 Duplicate CMS Navigation Path 
 

Action Screen Capture 

This is caused by two channels with the same 
name. Every active channel must have a 
unique name.  

 

5.4.2 Connection is not authorized 
 

Action Screen Capture 

Normally this is a password error.  

 

The IP address is correct, the software 
communicated with the rack – but the 
connection was not authorized. 

 

5.4.3 Connection Failed 
 

Action Screen Capture 

Normally this is an IP Address (or network 
connection) error.  

 

You will also get this error after a rack power 
cycle - if the SAM module is still rebooting. It 
takes a full 2 minutes for the SAM to fully 
reboot and accept a connection. 
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5.5 Troubleshoot the IP Address 
 

Action Screen Capture 

Open Network Connections and view the properties 
of your network port. 

 

 

 

 

 

 

 

Select Internet Protocol Version 4. 

 

 

 

 

Verify your computer IP address. It should be 
similar (but not the same) as the VIBROPORT 
8000 rack. 

 

 

 

 

 

Open the Command Prompt 

 

Type “ping 192.168.0.1“(for example) 

Verify the VIBROPORT 8000 responds. 

Unplug the ethernet cable 

Ping again, and verify the VIBROPORT 8000 does 
not respond.  

 

Plug the Ethernet cable back in. 

 

Done.  
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5.6 Laptop Hibernation Settings 

Most laptops will hibernate when not in use. This will stop data collection. Before using a laptop to 
collect data, make sure that the following are set. 

 

Option Setting 

Sleep (battery power) Never 

Sleep (plugged in) Never 

Hibernate after (battery powered) Never 

Hibernate after (plugged in) Never 

When I close the lid (on battery) Do nothing. 

When I close the lid (plugged in) Do nothing. 

5.7 Other (Requires VC-8000 MPS Software) 

Some troubleshooting steps will require you to install the VC-8000 MPS software. This software was 
also included with the VIBROPORT 8000. 

Please refer to the VC-8000 MPS software, and the VC-8000 Operation and Maintenance manual 
(Doc# S1079330). Both are available for download at the BK Vibro website (look for the link to 
“Product Instructions” or “Software” in the Downloads section of the website). 

5.7.1 I Forgot the Password 

Requesting a password reset file can take 24 hours (one working day). Data Collection is still 
possible, but rack configuration changes are not possible without the password. 

Connect to the rack, upload the rack configuration, save the rack configuration while you are still 
connected to the rack. This will create a “Maintenance file”. Send the maintenance file to BK Vibro 
tech support (techsupport@bkvibro.com) requesting a password reset. 

See the VC-8000 Operation and Maintenance manual (Doc# S1079330) for password reset 
instructions. 

5.7.2 Update or View Firmware Revisions 

See the VC-8000 Operation and Maintenance manual (Doc# S1079330) 

  

mailto:techsupport@bkvibro.com
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5.8 Frequently Asked Questions 

5.8.1 Definitions 
 

Setting Definition 

CMS Navigation Path (Asset) The machine or machine train (i.e. Motor, or Unit 1). 

Boost Mode 

Low Trigger (RPM) 

High Trigger (RPM) 

 

(Rarely used) Collects waveforms as fast as 
possible (i.e. one long continuous waveform).  

This is useful for machines that start fast (i.e. 
seconds, rather than minutes).  

The Low/High triggers are used to 
activate/deactivate Boost Mode data collection. 

Boost Waveforms Collects 10 seconds of continuous waveforms.  

CMS-SD CMS data collection on the SD card on the VC-8000 
SAM module. Provides a backup of data to ensure 
no data is lost. 

CMS-XC CMS data collection to an external computer (XC). 
This is the primary database used for portable data 
collection. 

CMS-PI CMS data collection to a PI Server. For permanently 
installed systems.  

Group Channels Forces simultaneous waveform collection for all 
selected channels with the same Phase Trigger 
association (i.e. waveforms will have the same 
timestamps). 

High-Z Input Raises the input impedance of the UMM. This is 
used when the input is coming from a buffered 
output – rather than a sensor. 

I-Factor % Percentage change required to trigger a waveform 
to be collected. Percentage is calculated from the 
Full-Scale setting, or on the Danger Alarm setting (if 
enabled). 

Direct, 1X, 2X are monitored and can trigger I-Factor 
waveform collection. Gap, and Phase do not trigger 
waveform collection.  

For more on I-Factor see application note 
S1224323. 

Adaptive I-Factor Used to automatically raise the I-Factor % if the 
channel starts to collect too many waveforms. 
Typically, only used on permanently installed 
systems.  
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5.8.2 Do I Need PI?  

No, you do not need PI installed on your laptop. The VIBROPORT 8000 will store data to a folder on 
your hard drive. 

5.8.3 How Does the VIBROPORT 8000 Manage Time? 

All data from the VIBROPORT 8000 is stored in UTC time. It is displayed using the time zone from 
your display computer. 

For example: Data that is exported to a .CMS file (for sharing) will also be stored in UTC time. If you 
store data (you are in Pacific Time), and email it to a colleague (he is in Eastern Time), your 
colleagues computer will display the data in Eastern Time. For example, the “event” that occurred at 
3:00 PM (Pacific) will be displayed (on your colleague’s computer) at 6:00 PM (Eastern). If your 
colleague wants to view the data converted to Pacific Time, he must change his laptop to Pacific 
Time, and restart the CMS software. 
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Contact 
Brüel und Kjaer Vibro GmbH 

Leydheckerstrasse 10 

64293 Darmstadt 

Germany 

 

Phone:  +49 6151 428 0 

Fax:  +49 6151 428 1000 

Brüel & Kjær Vibro A/S 

Skodsborgvej 307 B 

2850 Nærum 

Denmark 

 

Phone:  +45 77 41 25 00 

Fax:  +45 45 80 29 37 

BK Vibro America Inc. 

1100 Mark Circle 

Gardnerville NV 89410 

USA 

 

Phone:  +1 (775) 552 3110 

 

Corporate E-Mail: info@bkvibro.com Homepage: www.bkvibro.com  
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